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Thermo-Calc Version 2022b Highlights

Highlights

★ Thermo-Calc
○ Improved look and feel throughout the graphical user interface
○ New plot themes and several related plot improvements
○ New calculation examples for thermophysical properties and a new

additive manufacturing application example
○ For Scheil simulations you can now calculate from the gas/liquid

transition temperature
○ Plus many additional bug fixes and improvements for all products

★ Property Models and Model Libraries
○ In the Steel Model Library there is a new Ferrite Property Model and

improved CCT and TTT
○ Several improvements to the Yield Strength Property Model

★ TC-Python and TC-Toolbox for MATLAB®
○ Process Metallurgy Module now available
○ New timeout available for calculations

★ Databases
○ New database for ultra-high temperature materials (TCUHTM1)
○ New versions of databases for nickel (TCNI12 and MOBNI6), copper

(TCCU5 and MOBCU5), high entropy alloys (TCHEA6), and nuclear
materials (MEPH20 and NUCL20)

○ Updated databases for solders (TCSLD4.2) and magnesium (TCMG6.3)
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Thermo-Calc

Improved Look and Feel

Thermo-Calc has a new look and feel with the 2022b release. The primary purpose is to have a more

modern graphical user interface (GUI) and improve the user experience. As the Thermo-Calc Software

product line has expanded in recent years with additional modules and property libraries, the software

has become increasingly complex. For those working in Graphical Mode, the main My Projects

Configuration window is reorganized into categories to help you more easily locate templates and

additional resources. A Getting Started section is added to help new users learn about or gain a deeper

understanding of the software.

Some of the new categories on the My Projects Configuration window, which include links to the website

(the Getting Started guide and video tutorials) as well as local resources (the help and example files). All

the templates are still accessed from this window but are reorganized into categories and have new icons.

Additionally, all of the icons in the software are updated with a simpler, more modern feel so that they

are easy to identify on the range of screen sizes and resolutions in use today.  The overall appearance of

the software, such as the buttons and form fields, has also been simplified to make it easier to navigate

through the program.
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An example of the new icons you will see when working in Graphical Mode. There are also some changes

to the icons in the Console and Console Results windows when working in Console Mode as shown below.

New Plot Themes and Related Plot Improvements

The 2022b release introduces predefined themes to provide more flexibility when designing and setting
up your plot outputs. A useful change for some users compared to previous software versions is that you
can have different global settings applied for Graphical Mode or Console Mode plots at the same time.
There are also several other plotting improvements related to the implementation of the new themes as
well as various bug fixes described in these release notes.

There is additional  information related to the new themes described in the Help. In Thermo-Calc
press F1 and search for “plot theme”.

Predefined or Custom Plot Themes

A new section - Theme for plot settings - is available with predefined themes for both Graphical and
Console Mode. You can also work with themes from both the global or local settings windows, which are
accessed slightly differently for the two modes although the options are mostly the same.

● Global settings are accessed on the Tools > Options window.
● Local plot settings are accessed from the Results window when you right-click an individual plot

and choose Properties.
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Apply Predefined Themes

There are four predefined themes: Default, Large, Small, and Publication. The four predefined themes
have most of the same settings where key differences include attribute changes to font sizes, plot area
size and type, scaling, data point marker radius, tick mark length, line width, and image quality.
Predefined themes cannot be renamed or deleted, but can be exported and used as a template for
custom themes.

Create and Apply Custom Themes

In the Theme for plot settings section, and if you make a change based on a predefined theme, it can be
saved as a new custom theme (Save as), and these custom themes can be reused to create additional
themes. Themes (including the predefined ones) can be exported and you can import your own custom
themes using *.json files. Once a custom theme is available in the list, it can also be updated (by clicking
Save) and deleted as needed from the list.

There are many options to work with the settings, either to create a custom theme used and assigned
globally from the Options section, or when working in the Results window for a specific plot.

Apply Themes Locally or Globally to Project Files

For Graphical Mode only, and when opening project files, a predefined or custom plot theme can be
automatically applied to all plots (global setting), or just for a specific file (local). There are two check
boxes that control this:

● Locally on the Open File
window, it is called Apply
plot theme from
Tools/Options

● Globally in the Theme for
plot settings section for
Graphical Mode, it is called
Apply the selected theme to
opened file [.tcu]

● NOTE: If you double-click or
drag and drop to open a
project file it automatically
uses the global settings in
Thermo-Calc (which may or may not be to apply a theme, i.e. the Apply the selected theme to
opened file [.tcu] check box may be selected).
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Plot Area Size Improvements

Additional functionality is also added to the Plot Area Size section to support and expand on the new
theme settings.

The two new sections are used by default for the Publication theme. The Fit the plot area size to a
square with a width/height of the enclosing window option means that the minimum value of the width
and height of the Results window is used as the dimension of the fixed plot area and in a square.

The new Scale plot attributes using the system scaling factor checkbox is selected by default for all
themes. This maintains consistent attribute sizing between different plots. Click to deselect it to scale all
plot attributes (i.e. labels, font size, axes, tick marks, etc.) independently of the screen size and
resolution.

The default settings for the
Publication theme under the
Plot Area Size section.

Note that there are also
additional improvements and
bug fixes for plots listed below
in the applicable sections, i.e.
Thermo-Calc Improvements
and Bug Fixes.

LaTeX Label Improvements

Several improvements have been made to LaTeX formatted text, which can be used in plot labels, plot
axis labels, and plot titles. The most significant improvement is that LaTeX output is now made in vector
format instead of using an overlaid image, which often was rendered too blurry. The LaTeX output is now
as crisp as anything else on the plots. This improves the quality of images saved to file.

Some other important updates to LaTeX labels are:

● The default text style has been changed to non-italic sans serif, to better match the default plain
text font.

● The color of LaTeX labels can be changed.

An example of a label created using the LaTex
formatted text option in either Graphical or
Console Mode. Details about how to enter this
information is found in the help (press F1 and
search for LaTeX). You can also now choose a color
to apply to the label text.
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Scheil: Calculate from the Gas/Liquid Transition Temperature

The option to calculate from the gas/liquid temperature, i.e. from the temperature above which the
liquid phase is no longer stable, is added to the Scheil calculation options in Graphical Mode, Console
Mode, TC-Python, and TC-Toolbox for MATLAB®.

● In Graphical Mode the new option is added as an option on the Scheil Calculator Configuration
window.

● In TC-Python and TC-Toolbox for MATLAB® a new method calculate_from_gas is added to the
ScheilOptions.

● In Console Mode there is a new command CALCULATE_FROM_GAS.

When choosing the option, equilibrium calculations are performed at set temperature intervals above
the liquidus temperature. These equilibrium calculations are performed at 5 K intervals in the two-phase
region between the gas/liquid temperature and the liquid/gas temperature, which is the temperature
below which the gas phase is no longer stable. When nearing the phase change at liquid/gas temperature
the equilibria are calculated at decreasing intervals. Between the liquid/gas temperature and the liquidus
temperature the equilibrium calculations are performed at 50 K intervals, and from the liquidus
temperature the Scheil solidification simulation is performed as usual.

When running in Graphical Mode, the gas/liquid temperature, liquid/gas temperature and liquidus
temperature are collected in the Event Log at the end of the simulation.

An example of where in Graphical Mode to find the new option Calculate from: Gas on the Scheil
Calculator. This Calculate from section has also been moved from the Advanced Options section
compared to previous versions. The option on the Phases and Phase Constitution tab is available when a
gas phase is selected for the database on the System Definer.

9



Release Notes
Thermo-Calc Version 2022b

Changes to Graphical Mode Project File Handling

A project file has the extension *.tcu and is specific to working in Graphical Mode. A variety of
important changes are introduced in this release to address the ongoing challenges of backward
compatibility and the continued improvements and additions to the design and settings within
Thermo-Calc. As the result of several recent bug reports of extremely slow opening of project files, where
once opened there were still many errors, it is now NOT possible to open project files with results in a
different version of the software in which the results were originally saved, i.e. a 2022b project file
including results is best opened in version 2022b. Now a project file is converted and maintains the
structure and design of the simulation, but no results are included.

The primary changes are related to project files with or without results (for new versions of
Thermo-Calc), a new option to open recent files, and that old project files containing results will be
converted without results. There is also a related and new check box described for the New Plot Themes
and Related Plot Improvements.

Opening Projects without Results

Starting with 2022b project files, It is now possible to open projects without results, even if the project
has saved results. The Open project with results if present check box on the Open File window controls
this. Note that for older project files between 2015a and 2022a, these are now always opened without
results even if this check box is selected. In this case an additional window prompts the user for what to
do next. See Converting Old Projects with Results.

Opening Recent Project Files

A new menu option is available. Select File → Open
Recent Project and choose from the list of projects
or click Clear Recent Projects to reset the list. Up to
the last 10 projects are listed and numbered in the
order in which they were last opened.
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Converting (Opening) Old Projects with Results

Starting with Thermo-Calc version 2022b, you can continue to open and thus convert an older project file
created between versions 2015a to 2022a but if it also includes saved results from a previous version,
these are now not immediately available. You can still convert the file and regenerate the results.
Whenever a file is converted, a backup file is created, which you can rename and reuse in the original
version of the software where it was created. The backup file is saved in the same folder as the original
file.

These changes are introduced due to the challenges of backward compatibility and the continued
improvements and additions to the design and settings within Thermo-Calc.

The new way that Thermo-Calc handles opening project files that include results is that you are prompted
with information to either open the file without results or cancel the action. The version in which the
results were calculated is identified in the Old project file with results window as well as the version (in
this case, 2022b) of the software in which you are opening it in.

There are extensive instructions included in the help detailing all the options related to saving and
opening project files, both with and without results. In Thermo-Calc press F1 and search for
“converting a project file”.

The prompt window that gives you the option
to open an old project file with or without
results in 2022b. If you click Cancel, you can
open the project file in the original software
version, in this case 2020b. If you click
Continue, the project file is converted and the
results are overwritten. There is a backup file
saved in this case, which you can rename and
reuse as needed.

Other Bug Fixes Related to Project Files

Also see bug fixes in the section Project File Related, which generally are improved or eliminated with the
new way of handling project files.

New Thermo-Calc Examples

There are also several new examples described elsewhere in this document:

● TC-Python and TC-Toolbox for MATLAB® see Five New Examples.
● Ferrite Property Model see New and Updated Examples.
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Thermophysical Properties General Examples

Five new examples in both Console Mode and Graphical Mode are available to demonstrate the use of
these thermophysical properties: Molar volume, electrical resistivity and thermal conductivity.

Molar Volume and Thermal Expansion

The molar volume examples calculate volumetric thermal expansion coefficients of the L12-type Al3Sc
and the L12-type Al3Zr, respectively. Both Al3Zr and Al3Sc are modeled as the same phase (named as
AL3SC, since Al3Sc is stable while Al3Zr is metastable).

In Graphical Mode there is one project file and in Console Mode there are two macro files to
demonstrate this. When in GM or CM, from the menu choose Help > Example Files > Thermo-Calc

● Graphical Mode: T_15_Molar_Volume_and_Thermal_Expansion_Coefficient.tcu
● Console Mode: open the tcex58 and tcex59 folder for the examples

Electrical Resistivity and Thermal Conductivity

The electrical resistivity and thermal conductivity examples calculate the electrical resistivity (ELRS) and
thermal conductivity (THCD) of pure Cu. The example makes a one axis (Graphical Mode) / step (Console
Mode) calculation over a wide temperature range, covering both the FCC_A1 state and the liquid state. It
plots thermal conductivity of the system (both FCC_A1 and liquid) and that of a single phase (taking
FCC_A1 as an example), respectively. Also it plots electrical resistivity of the system and that of FCC_A1.

The same example is also provided in Console Mode as tcex60.

● Graphical Mode: T_16_Electrical_Resistivity_Thermal_Conductivity_Cu.tcu
● Console Mode: open the tcex60 folder for the example

There is a companion video available for the Graphical Mode version of this example (T_16). Go
to the Video Tutorials page on the website or our YouTube channel to access various playlists.

Additive Manufacturing Applications

This is a new in-depth application example included with your installation. It uses the Property Model
Calculator and batch calculations to find the optimal composition for a titanium-based alloy to be used
for additive manufacturing applications. This application example, including detailed descriptions and
step-by-step instructions, is showcased on our website.

From the menu in Thermo-Calc choose Help > Example Files > Property Models > General

● File name: PM_G_13_Ti_Alloy_Design_for_AM.tcu
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Thermo-Calc Improvements and Bug Fixes

Below is grouped into related categories and whether it is fixed in Graphical Mode, Console Mode, or
both Modes. There are also sometimes related items listed in other sections and grouped by Add-on
Module as there are often multiple related items.

Graphical Mode

Project File Related

● When projects with calculated results created with a different GES version than selected from the
Tools > Options window, the results are discarded, since they are not 100% compatible.

● Fixed an issue when opening project files with results and calculations that were then still run
even if there was an incorrect GES version or other things stored in the cache for certain
calculators such as Property Model, Material to Material, and Process Metallurgy. This is also
fixed based on the new functionality where old project files with results cannot be opened in
2022b.

Table Related

● Improved readability of the list of constituents in the Table Renderer output. Now these are
shown in several rows in the equilibrium table instead of extending in one row across.

● Fixed a bug for the Table Renderer where previously tabulating activity referred to a phase did
not work for partitioned ordered phases.

● Diffusion quantities (tracer/intrinsic/chemical diffusion coefficient, and mobility quantities) are
now shown in the Table Renderer when the composition is used as a stepping quantity.

● Fixed a bug where the volume fraction of a phase was not listed in the Table Renderer if the
phase name was not written in all capital letters in the database.

● Fixed a bug where the creation of new composition sets during a step calculation could
sometimes prevent tabulating quantities with the All Phases option selected.

Plotting Related

● Previously when the unit of temperature was saved in Celsius for a TTT plot it always loaded as
Kelvin when a project (*.tcu) file was opened, i.e. it ignored the Celsius unit when originally
saving the file.

● 3D plot charts now support hardware rendering (GPU rendering) for all operating systems.
● Fixed an issue during plotting where the software could hang after clicking the Perform button a

few times.
● Fixed a bug where tracer diffusion coefficients for different components did not plot correctly.

Calculation Related

● Fixed a bug related to using uncertainty calculations in the Property Model Calculator. Previously,
after selecting elements in the System Definer, the settings for the randomized quantities were
sometimes mixed up when opening a project file or when cloning or creating a calculator.

● The formula for density of phase is corrected.
● Previously, for the Equilibrium Calculator, the temperature, pressure, and system size were reset

in condition input fields to the average stepping value when used as the stepping quantity and
the condition value is lower/higher than the min/max stepping value. These are now only reset in
calculation.
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● Fixed an issue on Windows where spaces in the path to the temporary directory caused
calculations using the Diffusion Calculator and Scheil Calculator to fail. Also see File Names and
File Paths.

General

● Fixed a bug on the System Definer where the reference temperature and pressure did not change
with the unit.

● Improved several dialog box prompts where there was inconsistent behaviour for the Close (X),
OK, and Cancel buttons.

General Property Models

Below are improvements and bug fixes for the General Property Models included with Thermo-Calc. Also
see Yield Strength Model, Steel Model Library, and Nickel Model Library.

● For the Equilibrium Model, added some missing quantities to the Quantity Definitions list:
Thermal conductivity, Thermal resistivity, Thermal diffusivity, Electric conductivity, Electrical
resistivity, Dynamic viscosity, Kinematic viscosity, and Surface tension.

● The temperature is shown once for the grid option in the Z-axis quantity list in a Plot Renderer.
The composition and temperature are shown for the one-axis option in the quantity list in Plot
Renderer when they are not selected as stepping quantities.

● The Property Model configuration panel now expands for readability as expected when
parameters are added.

Yield Strength Property Model

The Yield Strength Model is a General Property Model included with Thermo-Calc. It is further specialized
and also available with the Precipitation Module (TC-PRISMA). Also see General Property Models, Steel
Model Library, and Nickel Model Library.

● The following is implemented for the Simplified model (general) and Seidman model (Al-base).
The mean precipitate radius given by the user is transformed to a Lifshitz-Slyozov-Wagner particle
size distribution (LSW PSD). The distribution is stepwise integrated and the mean radius for all
sections are used to calculate a partial precipitate strengthening contribution. The use of a PSD
smoothes the transition between the cutting and Orowan regions.

● A change is made to the standalone Yield Strength Property Model to make it consistent with the
Precipitation Module (TC-PRISMA) version. Previously the standalone model used mole fraction
of precipitate and yield strength, now both use volume fraction precipitate.

● Specifically for the Precipitation Module (TC-PRISMA) version of the Yield Strength Model:
○ Implemented the use of precipitate size distribution (PSD), which uses the calculated

mean radius from a precipitation simulation instead.
○ Fixed where it sometimes had the wrong precipitate phase selected.

● Fixed a calculation failure when only one element is selected for the Single Calculation type.
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● When using the Yield Strength Property Model with the Reppich model (Ni-base) as the
Precipitation strengthening model in a calculation, you can select a new checkbox to calculate
the antiphase boundary energy. The
software uses the stand alone APBE
model in the Ni-library from within
the Yield Strength Model for the
calculation. Note: The APBE can only
be calculated for gamma prime. If
the selected precipitate phase is not
gamma prime, the user defined
value in the configuration panel is
used.

● A temperature dependence of the form A*exp(-B/T) is implemented for pure elements in the
Yield Strength Property Model. The relevant elements are: Ag, Al, Au, Be, Ce, Co, Cr, Cu, Dy, Er, Fe,
Gd, Hf, Ho, Ir, La, Mg, Mo, Nb, Nd, Ni, Pd, Pt, Rh, Sm, Ta, Ti, U, V, W, Y, Zn, and Zr. Further to this
improvement all solid solution strength model parameters have been re-optimized to maintain
accuracy stated in the original model.

● Result quantity Fraction of precipitate was not set. The result quantity for volume fraction of
precipitate phases existed in earlier versions and is now replaced.

● One of the general Property Model examples has an adjustment to the plot variable used.
PM_G_04_Yield_Strength.tcu is now changed to plot Total precipitation strengthening instead of
Total yield strength.

Both Graphical and Console Mode

Plotting Related

● When a plot is reopened having a max limit for temperature lower than the default minimum
value (500), the default maximum value (3000) was shown as the max limit.

● A single point data is shown as a star (symbol 208) even if the None data points marker is
selected.

● From the Tools > Options window (Plotting), fixed a bug related to when you clicked Reset to
original settings (at the bottom of all of the Options settings windows). Now when you click the
button on the applicable window, the Border width, Data points marker size, Header font, and
Line width defaults are correctly reset.

● Fixed a bug that caused extremely slow tabulation when tabulating composition of all phases.
● For Scheil with back diffusion or with fast diffusers, the variable Distribution of component in

phase is temporarily unavailable. The reason for this is a so far unresolved issue with the
amounts not summing up correctly.

● Fixed a bug that prevented images from being saved when you right-clicked in the Results
window or clicked the button on the Configuration window.

● The automatically selected line colors in plots had a random behavior regarding which color was
selected for a given quantity. This is fixed.

File Names and File Paths

● Saving POLY3 files no longer defaults to the /tmp directory. See below.
● Double clicking PAR and TDB files now works if the paths contain white space. See below.
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● From the Tools > Options window (General tab) you can now change the path to the Temporary
Directory folder, where files are stored during calculation, such as Console Mode state files (e.g.
State_4064824901731140183.POLY3), log files, and so forth.

● In the tc_initd.tdb file it is now possible to add databases with absolute file names with white
space, if the path is surrounded by quotation marks, e.g.:

TEST "G:\My Drive\My Folder\Test.TDB" My test database v0.1!

IMPORTANT. The use of absolute paths should be used with caution as these are not portable.

General

● Ionic liquid model with only VA in the second sublattice, failed when using global minimization.
● Improvements in Scheil with solute trapping calculations when the primary solid phase is first

formed.

Console Mode

Plotting Related

● Addressed issues with some Console Mode plot settings not being honored. Improves the
behavior of: SET_RASTER_STATUS, SET_TIC_TYPE, PLOT_SYMBOLS_AT_NODE_POINTS, and
SYMBOL_SIZE.

● Bug fixes related to Console Mode plots using the inverse axis include correcting the size of
symbols for experimental data, adding tooltips on the diagram to show both the linear and
inverse values, showing the inverse axis label as 1 over the quantity name, and including tick
marks and header fonts when the axis type changes to inverse.

● The SET_PREFIX_SCALING command, which enables scientific notation, works now. The
exponent part is placed under the X-axis and on the left side of the Y-axis.

Gibbs Energy System (GES5 and GES6)

Below relates to improvements and bug fixes for the core calculation engine used throughout the
product range.

For further information about the changes to GES, see the 2019b , 2020b, 2021a, 2021b, and
2022a release notes on the website.

Database Related

● POLY3 and DIC files using user database(s) with GES6 are now portable.
● LIST_DATA command (GIBBS module) GES6 fixes:

○ Fixed an issue where the command would sometimes fail.
○ It now lists only the species that are actually used by the selected phases.
○ Fixed so the command includes the V parameters that are used by PARROT.
○ Previously it sometimes printed the phase in parameter definitions using upper case

when the phase definitions used lower case.
● The order in the database of constituents on the second sublattice no longer matters.
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General

● Improved the user experience when changing the system interactively in Console Mode.
● Neutral reference in ionic liquids now gives the correct results.
● Fixed wrong magnetic contributions for so-called partitioned never disorder phases in GES5 and

GES6.

Steel Model Library

Below are details about the Steel Property Models included with Thermo-Calc with the addition of a
licence for the Steel Model Library. Also see General Property Models, Yield Strength Model, and Nickel
Model Library.

New Ferrite Model and Improved CCT and TTT

A Ferrite Property Model is added to the Steel Model Library. This new model calculates the
transformation product from austenite that happens when you have low carbon and hold it at a high
temperature for a long time.

The new Ferrite model has also been incorporated into the TTT Diagram and CCT Diagram Models, which
combine the Pearlite, Bainite, Martensite, and Ferrite Property Models and calculate the kinetics of
concurrent transformation of austenite into pearlite, bainite, martensite, and ferrite.

This new Ferrite model is available to users who have a licence for the Steel Model Library and a valid
Maintenance and Support Subscription. Learn more about the Steel Model Library on our website where
there are links to additional resources.

New and Updated Examples
A new example is added to help users learn about this Ferrite Property Model. Three existing examples

are updated for the TTT Diagram Property Model and CCT Diagram Property Model. For these examples,

from the menu in Thermo-Calc choose Help > Example Files > Property Models > Steel, then select files

demonstrating the use as follows.

● TTT Diagram = PM_Fe_06_Fe-C-Mn-Si-Cr-V_TTT.tcu

● TTT Diagram, CCT Diagram, and other Steel Models =

PM_Fe_07_Hardenability_Design_of_Steel.tcu

● CCT Diagram = PM_Fe_08_Fe-C-Mn-Si-Cr-V_CCT.tcu

● Ferrite = PM_Fe_09_Fe-C-Ni_Ferrite.tcu

Tip: As of this release, you can also click the Example Files
icon on the My Project Configuration window to directly
access the file location.
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Improvements and Bug Fixes

Improved algorithm for time integration for Pearlite and Bainite Property Models, which fixes some
previous problems including:

● In some cases, calculation gives incomplete austenite-to-pearlite transformation when the
transformation should be complete;

● In some cases, when cooling rate is lowered in a CCT Diagram calculation, Pearlite-start can be
unphysically overtaken by Bainite-start.

Nickel Model Library

Below are details about the Nickel Property Models included with Thermo-Calc with the addition of a
licence for the Nickel Model Library. Also see General Property Models, Yield Strength Model, and Steel
Model Library.

Bug Fix

A correction to spelling for a phase name for the Coarsening Property Model. Previously M23C6 was
incorrectly named M6C3 when selecting it from the precipitates list.

TC-Python and TC-Toolbox for MATLAB®

Process Metallurgy in TC-Python and TC-Toolbox for MATLAB®

The Process Metallurgy Module is now available in both TC-Python and TC-Toolbox for MATLAB®, our two
most powerful APIs. All functionality that is currently available in the Graphical Mode version of the
Process Metallurgy Module is now available in both of these APIs, including equilibrium calculations and
kinetic process simulations.

The integration into the APIs now gives the full power of a programming language to the Process
Metallurgy Module. But it also makes it easier to use for integrating calculations and process simulations
directly with the data available in steel plants, for example, from a data warehouse. However, such
integrations currently need to be developed by the user.

The strength of the Process Metallurgy Module is that thermodynamic calculations and even full
simulations of a liquid steelmaking process, such as a ladle furnace, can be set up easily, and the results
can be easily interpreted. For example, slag composition is directly available per component (CaO, Al2O3,
FeO, Fe2O3, etc…), not only per element.

This new integration is available to users who have a licence for the Process Metallurgy Module and
either TC-Python or TC-Toolbox for MATLAB®. Contact your local representative to learn how to obtain a
licence for these powerful new tools.
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Five New Examples

Five new examples are available in TC-Python and TC-Toolbox for MATLAB® to demonstrate how the

Process Metallurgy Module can be used in these APIs. Brief descriptions of the examples are also

included in the help.

TC-Python

● pyex_PMET_01_Single_adiabatic_equilibrium.py
● pyex_PMET_02_Stepping_adiabatic_equilibrium.py
● pyex_PMET_03_Mapping_isothermal_equilibrium.py
● pyex_PMET_04_Simple_process_simulation.py
● pyex_PMET_05_VOD_process_simulation.py

TC-Toolbox for MATLAB®

● matex_PMET_01_Single_adiabatic_equilibrium.m
● matex_PMET_02_Stepping_adiabatic_equilibrium.m
● matex_PMET_03_Mapping_isothermal_equilibrium.m
● matex_PMET_04_Simple_process_simulation.m
● matex_PMET_05_VOD_process_simulation.m

Timeout to Stop a Calculation

TC-Python and TC-Toolbox for MATLAB® now allow users to set timeouts for each calculation in a project

in order to prevent the program from hanging on incorrectly formatted calculations. If a calculation

cannot be completed in the set time, the program moves on to the next calculation, rather than aborting

the entire project. The timeout parameter is set in the Calculate method and is available with all

calculation types except for Single equilibrium stateless calculations.

Almost all calculation methods now have this optional parameter:

result = calc.calculate(timeout_in_minutes=2.0)

When used, the calculation runs at maximum for the time specified, and if not finished by then it throws
an UnrecoverableCalculationException.

Scheil: New Method

Also see Scheil: Calculate from the Gas/Liquid Transition Temperature where In TC-Python and
TC-Toolbox for MATLAB® a new method calculate_from_gas is added to the ScheilOptions,

Improvements and Bug Fixes in TC-Python and TC-Toolbox

● User database paths with white space now work. Also see File Names and File Paths.
● Fixed a bug with the method get_system_function where it would not always return a value

for zero-valued database functions.
● Fixed a bug that caused the method get_phase_parameter to return at most 256

characters of a database parameter description.
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Installation Related

Also see Installation for other changes related to general Thermo-Calc installations.

● A Python installation version 3.9 is included in the Windows installation to make it possible to run
TC-Toolbox on MATLAB® version R2022a and later. It's installed in a folder, with the name
python39, next to the old python 3.7 installation.

● Fixed the installer to correctly find the location of MATLAB® 2022a.
● Fixed a bug that prevented TC-Toolbox for MATLAB® from being selected as an option on the

installation window if the first attempt failed because MATLAB® was not found.

Details about the TC-Python and TC-Toolbox for MATLAB® installations are available in the
Thermo-Calc Installation Guide, which among other places, can be found on our website.

Deprecation and Removed Function Reminders

Legacy TC-Toolbox for MATLAB®: Deprecation with Version 2023a

The legacy version of TC-Toolbox for MATLAB® will no longer be supported as of Thermo-Calc version
2023a (December 2022) and users are encouraged to migrate their scripts to the new TC-Toolbox.

Removed Functions: No Longer Supported as of Version 2022b

The following functions were deprecated starting with 2021b and as of this release are no longer
supported.

Old Name New Name

set_fast_diffusing_elements
in class ScheilCalculation

set_fast_diffusing_elements
in ScheilCalculationType

Use it with the method with_calculation_type

with_back_diffusion with_calculation_type

set_homogenization_function with_function

Removed Functions: Stop Supporting as of Version 2023b

The following functions are renamed, and the old versions will be removed in 2023b (June 2023). Users
are recommended to update any scripts as soon as possible.

Old Name New Name

get_system_for_scheil_calculations use the regular get_system instead
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Process Metallurgy Module

Visit the Process Metallurgy Module on the website to access resources such as training videos,
publications, application examples, and much more.

Included with TC-Python and TC-Toolbox for MATLAB®

The Process Metallurgy Module is now available with TC-Python and TC-Toolbox for MATLAB®. See
Process Metallurgy Included with TC-Python and TC-Toolbox for MATLAB®

Improvements and Bug Fixes

● Fixed a bug related to when the unit of transfer of phase group was potentially wrong in the table
for a process simulation. This happened when heat was added to the process model and then
Transfer of Phase Group was added by reopening the Edit Process Model dialog.

● For Process Simulations, the setting option Absolute Amount is no longer selectable as an Input
Type because the option was not useful in this context.

● Fixed that the unit of a gas addition was not set in certain situations if the configuration had been
loaded from a file.

● There is a significant improvement to the performance of process simulations using extensively
continuous additions. For example, tests using this feature for industrial ladle furnace simulations
to model slow dissolution of additions have confirmed a performance improvement of around
35%.

Precipitation Module (TC-PRISMA)

Visit the Precipitation Module (TC-PRISMA) on the website to access resources such as training
videos, publications, application examples, and much more.

Improvements and Bug Fixes

● See the Yield Strength Model for details of bug fixes applicable to the Property Model, which is
also available in an advanced form in the Precipitation Module (TC-PRISMA).

● On the Precipitation Calculator, the Preexisting size distribution checkbox is no longer wrongly
deselected after a calculation has finished.
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Diffusion Module (DICTRA)

Visit the DIffusion Module (DICTRA) on the website to access resources such as a tutorial, training
videos, publications, application examples, and much more.

Improvements and Bug Fixes

Graphical Mode

● Several issues in plotting with diffusion calculations having regions created during the simulation
are fixed.

● Previously after opening project files (or cloning calculators) with a Diffusion Calculator,
simulations failed when calculating stoichiometric phases.

● Fixed a rare case that made plotting diffusion simulation results impossible after resaving the
project file.

Both Console and Graphical Mode

● Fixed an inconsistent equation shown in both Console Mode help and the online help. Now the
equations as part of the text for the two boundary condition commands, Activity Flux Function
and Potential Flux Function (as part of SET_CONDITION command) include molar volume
expression.

● Fixed an issue with diffusion coefficients calculated wrongly if the interpolation scheme was
turned on, DICTRA classic with complex phases was used, and temperature depended on time.

Console Mode Only

● Resolved an issue that made the following variables unavailable: DT, QT, QC, QI, FC, FT and FI.

New Thermodynamic and Kinetic Databases

All the thermodynamic and kinetic databases have dedicated web pages where new and updated
Technical Information and Example Collections are available in addition to links to examples,
publications, webinars, and many other resources can be found.
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TCS Ultra-high Temperature Materials Database (TCUHTM1)

The TCS Ultra-high Temperature Materials Database (TCUHTM1) is a thermodynamic database for
ultra-high temperature materials that can be used for hypersonic aircraft and space vehicles. These are
typically non-oxides with melting/decomposition temperatures in excess of 3000 °C. Examples include
borides, nitrides, and carbides of Group IV-V metals in the periodic table, such as ZrB2, HfB2, ZrC, HfC,
TaC, and HfN. SiC was used to improve oxidation resistance. The database can be used to calculate phase
diagrams and thermodynamic properties of assessed systems, but also for predicting phase equilibria,
melting temperatures, and simulating operation processes for a wide range of compositions.

TCUHTM1 enables predictions (such as multicomponent phase equilibria calculations, equilibrium
solidification simulations, and Scheil solidification simulations) to be made for multicomponent systems
and alloys of industrial importance. This means that the database can be used to extrapolate to
higher-order systems by combining several critically assessed systems.

There are seven included elements B, C, Hf, N, Si, Ta, and Zr.

A hybrid approach of experiments, first-principles calculations and CALPHAD modeling have been used to
obtain thermodynamic descriptions of the constituent binary and ternary systems over the whole
composition and temperature ranges. All the stable solution phases and intermetallic compounds that
exist in each assessed system are included. In most cases phases having the same crystal structure are
merged as the same phase.

The database contains:

● 21 assessed binary systems
● 26 assessed ternary systems
● 35 phases

There is a new Ultra-high Temperature Materials page on our website where you can access an
example collection and the technical information.

TCS Ni-based Superalloys Database (TCNI12)

New Element

● Phosphorus (P) is added to make it a 31 element framework.

20 New Binary Systems

● The following systems are at least partially assessed. Al-P, B-P, C-P, Ca-P, Co-P, Cu-P, Cr-P, Fe-P,
Mn-P, Mo-P, Nb-P, Ni-P, P-Pd, Pt-P, Ru-P, S-P, Si-P, Ti-P, V-P, and W-P.
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29 New Ternary Systems

Al-Fe-P B-Ni-P C-Fe-P Co-Fe-P Co-Ni-P Co-P-V

Co-P-W Cr-Fe-P Cr-Nb-P Cr-Ni-P Cr-P-Ti Cu-Fe-P

Cu-Ni-P Fe-Mn-P Fe-Mo-P Fe-Nb-P Fe-Nb-Si Fe-Ni-P

Fe-P-Si Fe-P-Ti Fe-P-V Fe-P-W Nb-Ni-P Nb-P-Ti

Ni-P-Ti Ni-P-V Ni-P-W Ni-SI-P P-V-W

Binary and Ternary System Updates

● Fe-Nb updated, improved MU and C14_LAVES boundaries.
● Nb-Ni, Fe-Si, Nb-Si updated metastable C14_LAVES description.
● Co-W updated so that Co3W D019 is stable to low temperature.
● Fe-Nb-Si added.
● Fe-Nb-Ni updated, improved Laves boundaries.
● Co-Ni-Ti updated to correspond better with available phase diagram data.
● Al-Co-Ni updated to better fit thermodynamic and phase diagram data.
● Al-Co-W updated to destabilize FCC_L12#2 (gamma-prime)
● Co-Ni-W updated metastable FCC_L12 towards an improved description of Al-Co-Ni-W
● Nb-Ni-Ti fixed a bug relating to a slightly destabilized ternary phase.

Thermophysical Properties

● Viscosity and Surface tension updated:
○ Viscosity is now described for the ionic liquid phase (IONIC_LIQ)

● Electrical and thermal properties improved:
○ High-temperature trends of THCD are now better for commercial alloys.
○ ELRS of Cr-Fe rich Ni-base alloys were before quite over-estimated, now improved.

Phase Names/Phase Information

● AL-FE-SI ternary phases renamed to use their modern Greek letters, e.g. ALFESI_ALPHA >
ALFESI_ALPHA_TAU5.

● D0I_MO2B5 renamed to MO2B5_D8I, correct strukturbericht.
● All phase descriptions updated to our new standardized crystallographic information format.

Bug Fix

● Corrected minor typo in the Gibbs energy of the MUFEMO function, used in the MU_PHASE.
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TCS Ni-alloys Mobility Database (MOBNI6)

This database is compatible with TCS Ni-based Superalloys Database (TCNI12).

New Element

● Phosphorus (P) is added to make it a 29 element framework.

FCC_A1 Phase

Mobility parameters for 29 binary or ternary systems are added or reassessed:

● Four (4) binaries: Co-Mn, Co-Re, Cr-Pt and Ni-P
● Twenty-five (25) ternaries: Co-Cr-Mo, Co-Cr-W, Co-Mo-W, Co-Ti-V, Co-V-W, Ni-Al-Co, Ni-Al-Nb,

Ni-Al-Ta, Ni-Al-W, Ni-Co-Cr, Ni-Co-Mo, Ni-Co-Re, Ni-Co-Ru, Ni-Co-W, Ni-Cr-Mo, Ni-Cr-Nb, Ni-Cr-Ti,
Ni-Cr-V, Ni-Cu-Cr, Ni-Cu-Mo, Ni-Cu-Ti, Ni-Fe-Ti, Ni-Fe-V, Ni-Mo-Ta, and Ni-Mo-W

FCC_L12 Phase

● Mobility parameters for three (3) ternary system are added or reassessed: Ni-Al-Ta, Ni-Al-Re, and
Ni-Al-W

BCC_B2 Phase

● Mobility parameters for one ternary system are assessed: Ni-Al-Co

LIQUID Phase

● Mobility parameters for one binary system are added: Ni-P

TCS Cu-based Alloys Database (TCCU5)

New Elements

● Two new elements, Ce and La.

New Binary and Ternary Systems

● 13 new binary systems: Cr-O, Cu-La, Cu-Ce, Cr-La, La-Zr, La-Ni, Ce-La, Al-Ce, Ni-Ce, Nb-Ni, Nb-Ti,
Ni-Ti, and Zr-O

● 11 new ternary systems: Ag-Cu-Si, Ag-Cr-Cu, Al-Ce-Cu, Ce-Cu-La, Ce-Cu-Ni, Cr-Cu-La, Cu-La-Ni,
Cu-La-Zr, Cu-Nb-Ni, Cu-Nb-Ti, and Cu-Ni-Ti

New Volume Data

● Volume data for the newly added phases are assessed or estimated.

TCS Cu-alloys Mobility Database (MOBCU5)

This database is compatible with TCS Cu-based Alloys Database (TCCU5).

New Elements

● Two new elements: Ce and La.

New Diffusion Data for FCC_A1 and LIQUID Phases
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● The self-diffusion and related impurity diffusion data for Ce and La were included in both FCC_A1
and LIQUID phases.

New System Assessments

● The complete and critical assessments for the following systems are implemented:
○ FCC Cu-Ti, Co-Mn, Ni-Mo, Cu-Ni-Mo, Cu-Ni-Ti, Cu-Co-Mn, Cu-Mn-Si, Cu-Ni-Al-Zn and

Cu-Ni-Al-Sn.
○ Liquid: Al-Ce and Cu-Ce.

Updated Description

● The description for FCC Ni-Ti is updated.

TCS High Entropy Alloys Database (TCHEA6)

In this release of the database, there is one new ternary system assessment plus major changes to 18
critically assessed systems. In addition, 19 ternary systems also had some minor changes and a complete
description of the gas phase is added.

Ternary Systems: New and Reassessed

● One new ternary assessment added: Al-V-Zr
● Reassessed 18 ternary systems: Al-Co-Ti, Al-Cr-Ti, Al-Mn-Ti, Al-Mo-Ti, Al-Ni-Ti, Al-Sn-Ti, Al-Ta-Ti,

Al-V-Zr, Co-Mo-Ti, Cr-Mn-Ti, Cr-Ti-Zr, Fe-Ti-V, Mo-Ti-V, Mo-Ti-Zr, Nb-Ti-W, Ta-Ti-V, Ti-V-W, and
Ti-V-Zr

Ternary Systems: Minor Modifications

● Adjustments for 19 ternary systems: Al-B-Ti, Al-C-Ti, Al-Fe-Ti, Al-N-Ti, Al-Si-Ti, Co-Sn-Ti, Cr-Si-Ti,
Cu-Ti-Zr, Mo-Nb-Ti, Mo-Ta-Ti, Mo-Ti-W, Nb-Sn-Ti, Nb-Ta-Ti, Nb-Ti-V, Nb-Ti-Zr, Si-Ti-W, Ta-Ti-W,
Ta-Ti-Zr, and Ti-W-Zr

Gas Phase Description

● Added a complete description of the gas phase in the 26 element framework.

IRSN Mephista-20 Nuclear Fuels Database (MEPH20)

New Element

● Added element Cr

New Binary Systems

● Added 14 binary systems related to the addition of Cr.  All X-Cr (with X=Ba, C, Ce, Cs, Fe, La, Mo,
O, Pu, Ru, U, Si, Sr, Zr) are modeled.

New Ternary Systems

● Added 6 fully modeled  ternary systems related to the addition of Cr. Cr-Fe-O, Cr-Fe-Zr, C-Cr-Fe,
Ce-Cr-O, Cr-Mo-O, and Cr-O-Zr.
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New Pseudo-binary Sections

For the following ternary systems where there is not enough experimental data, only pseudo-binary
sections are modeled:

● Ba-Cr-O modeled as BaO − Cr2O3

● Cr-La-O modeled as Cr2O3 − La2O,
● Cr-O-Si modeled as CrO − SiO2 and Cr2O3-SiO2

● Cr-O-Sr modeled as Cr2O3 − SrO
● Cr-O-U modeled as Cr2O3 − UO2

IRSN NUCLEA-20 Nuclear Alloys-Oxides Database (NUCL20)

Binary Systems

● Updated binary system: Ag-In as taken from E. Fischer et al., Calphad, 64:292–305, 2019
● Change to B-Ni: The name of the compound B0414NI0586 is changed to B7NI10.

Pseudo-binary Systems

● A bug fix for the pseudo binary system, Ba-Ca-O BaO-CaO

Ternary Systems

Change of name for three ternary stoichiometric phases:

● Fe-U-Zr:  The name of the ternary stoichiometric phases, FE333U250ZR417(e), FE6U71ZR23(l),
and FE503U18ZR32(k) are changed to FE4U3ZR5, FE6U71ZR23, and FE253U9ZR16, respectively.

Pseudo-ternary Systems

Two new systems and one reassessment:

● Al-Ca-O-Zr: Modeling of the CaO-Al2O3-ZrO2 pseudo-ternary system
● Al-O-Si-Zr: Reassessment of the Al2O3-SiO2-ZrO2 pseudo-ternary system
● Ca-Mg-O-Zr: Modeling of the CaO-MgO-ZrO2 pseudo-ternary system

Updated Thermodynamic and Kinetic Databases

TCS Solder Alloy Solutions Database (TCSLD4.2)

● Bi-Sn is re-assessed.
● Au-Co is updated.

TCS Mg-based Alloys Database (TCMG6.3)

● Remodeled Ag-Mg over the entire composition range, with a focus on the Mg-rich corner.
● The Al-Mg-Y description was refined via stabilizing the Al2Y phase.
● The GAS phase now has a complete thermodynamic description within the framework of the

database.
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Aluminium Demo Database (ALDEMO 4.1)

● Synchronization with TCAL8.1: updated thermal expansion of L12-type Al3Zr and Al3Sc (both
named as AL3SC); updated thermal conductivity of liquid Cu and electrical resistivity of solid Si.

● Added the list of ASSESSED_SYSTEMS, so that the assessed binaries and ternaries could be
calculated with the BINARY and TERNARY modules, respectively, in the Console Mode.

Installation

Thermo-Calc Changes

● Thermo-Calc communicates internally with its own subprocesses using network sockets. On
Windows, firewall rules are now added that prevents outside traffic from reaching those
processes. Before, the users sometimes were queried for this and that could result in
unnecessarily permissive settings. The details are described in the Thermo-Calc Installation
Guide, available from various places including our website.

● The Thermo-Calc update now checks if the calculation-engine dll is locked and kills all processes
that may be locking it when the user confirms to update.

● There are some installation fixes related to TC-Python and TC-Toolbox for MATLAB®. See
Installation Related.

Option to Save Backup User Created Files During Thermo-Calc Software Updates

Occasionally after a full release (such as 2022b), an interim release version, an update, is required to fix a
serious bug or to address an external issue that occurred after the full release. During the installation
process, several default folders are added to your system that include Documentation, Materials, and
Example files. Starting with 2022b, and only for an updated version of an installation, Thermo-Calc runs
a check of these default folders to determine if there are changed or new user files also saved to these
folders. For example, you might have saved a completely new project *.tcu file into the Examples folder,
or after running one of the included examples such as T_06_Serial_Equilibrium_Calculators.tcu, the
default file is changed and now includes results.

There are operating system differences regarding what backup files are saved if you are installing an
update on Windows versus macOS or Linux.

● On Windows operating systems, Thermo-Calc gives you the opportunity after the installation to
specifically save a backup folder of these user created or modified files to your Documents folder
when you open Thermo-Calc for the first time after the update. Note that the following file types
are not kept, i.e. these are excluded during the backup process: dll, exe, lib, mltbx, pdf, whl, html,
and htm.

● For macOS and Linux operating systems, the behavior is different due to limitations enabling the
identification of changes to some files. In this case, a backup of the full Examples folder is saved,
regardless of whether there are additions or changes to any file. No backups of Materials or
Documentation folders are made.
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In Thermo-Calc, press F1 to search the help for Updating the Software for details about the
location of the backup folders as well as the different behavior based on the operating system. This
information is specifically in the full Installation Guide PDF, a copy of which is found on our website.

Educational Package Updates of Note

The Educational Package is available after filling in a short form on our website. Most users are unlikely to
perform an update between releases and instead request, download, and install the latest version.
However, the following information is included for completeness.

● The Precipitation Module (TC-PRISMA) example P_01 now opens without errors. This is
automatically included with any new educational download.

● The Precipitation Module (TC-PRISMA) example P_11 is now available for users. This was
released with an updated version for 2022a in March i.e. automatically included with any
download since then.

Reminder for TDB Editor Installations to Update the Plugin

For anyone who installed the new TDB Editor (released with 2021a), you will need to update the plugin
for this after installing a new version of Thermo-Calc. When Thermo-Calc is updated to a new version,
VSCode should be updated too with the VSIX extension of the new release. This then includes the latest
bug fixes and any other changes or improvements.

If VSCode is not updated with a new VSIX extension, it will continue to work as before with the language
server of a previous release, as long as this release is not uninstalled. If the release is uninstalled, the VSIX
extension (and thus the TDB Editor) will cease to work.

This installation is done after Thermo-Calc is installed. Search the help (press F1 in Thermo-Calc) for
Installing VSCode and the TDB Editor.

Installation Disk Space Requirement

Due to precompiled databases added to the Thermo-Calc installation, 5 GB of disk space is recommended
for the 2022b installation. However, for Process Metallurgy Module users, due to the complexity of the
calculations, it is recommended that at least 50 GB of disk space is available.

Platform Roadmap

For information about platforms being phased out visit our Roadmap for Platform Support.
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